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1. คํานํา 
TR-102 คืออุปกรณแจงบอกตําแหนงระยะไกลที่บรรจุ GPS และ GPRS ไวดวยกันรูปราง

กระทัดรัด พกพาสะดวก ซึ่งไมเพียงแต TR-102 สามารถสงคาพิกัดตําแหนงไปยังโทรศัพทมื่อถือ
ดวย SMS เทานั้นยังจะสามารถสงคาพิกัดตําแหนงไปยัง PC ไดอีก ดวยการเชื่อมตอทางอินเตอรเน็ต
โดยGPRS อีกท้ังยังแสดงคาพิกัดตําแหนงน้ันบนซอรฟแวรแผนที่เฉพาะไดอีก TR-102 มีปุมโทรออก
อัตโนมัติ 3 เลขหมาย และปุมสงขอความฉุกเฉินหนึ่งปุม ดวยคุณลักษณะอยางนี้ทําใหสามารถ
ปองกัน หรือคนหาตําแหนงของเด็ก หรือคนชราที่หลงทางได และยิ่งไปกวานั้นยังสามารถใช TR-
102 ในเรื่องความปลอดภัย หรือจุดประสงค   อื่นใดที่เกี่ยวของกับการแจงบอกตําแหนงระยะไกล 
 

2. คุณลักษณะ 
1. เปนเครื่องคนหาตําแหนงสวนตัวดวย GPS/GPRS 
2. สื่อสารดวยระบบ GSM/SMS/GPRS 
3. ตัวรับสัญญาณ GPS ความไวสูงรับสญัญาณไดทุกทิศทาง 
4. Chipset รุน SiRF Star III ใหมล าสุดจับตําแหนงไดอยางยอดเยี่ยม แมในบริเวณท่ีมี

สัญญาณอ อน 
5. ระบบควบคุมระยะไกล สั่งงานผานโทรศัพทมือถือหรือดวยโปรแกรมออนไลน 
6. ตอบรับโทรศัพทได เปนการสื่อสารสองทาง 
7. ผูเฝามองสามารถติดตามบุคคลไ ดโดยไมตองรบกวนผูถูกติดตาม เปนการติดตามแบบ 

Real–Time 
8. คนหาตําแหนงของผูถืออุปกรณน้ีได เพียงแคกดปุมบน PC หรือ ผานโทรศัพทมือถือ

ดวย SMS (Short Messaging System) 
9. โทรออกได 3 เลขหมายตามที่ตั้งคาเอาไว 
10. ใชงานไดทั่วโลก เน่ืองจากสนับสนุนระบบคลื่น 4 ระบบ คือ GSM 

850/900/1800/1900 MHz GPRS และ Class 12 
11. ปุมฉุกเฉิน SOS จะสงคาตําแหนงที่แนนอน เพื่อการชวยเหลือดําเนินการอยาง

ทันทวงที 
12. ปุมฉุกเฉิน SOS แยกอิสระชัดเจน จะสงคาพิกัดตําแหนง GPS ผาน SMS ไปยังเลข

หมายที่ตั้งไวทันที เลขหมายฉุกเฉินที่ตั้งไวแตกตางจาก 3 เลขหมายโทรออกที่ตั้งไว
เ ดิมได 

13. อุปกรณสามารถเชื่อมตอกับ PC ทางชอง USB เพื่อต้ังคาใชงานตาง ๆ สายเคเบิล 
USB เปนอุปกรณใหมากับตัวเครื่อง 

14. ใหรายงานตําแหนงผูใชงานไดตามชวงเวลาที่ตั้งไว 
15. แสดงสถานะแบตเตอรี่ออนกอนไฟหมด ตัดความกงัวลวาจะไมสามารถติดตอไดใน

สถานะการณเฉพาะหนา 
 

คุณลักษณะซอรฟแวร 
โปรแกรม Call Center อันทรงประสิทธิภาพซึ่งใชไดใน Window 98/2000/XP สามารถรองรับการ
ติดตาม TR-102 ไดถึง 5เครื่องในเวลาเดียวกันดวยการใชงานในโหมด GPRS คลิกท่ีช่ือผูใช TR-
102 เครื่องใดเครื่องหน่ึงในโปรแกรม Call Center ก็จะดูพิกัดตําแหนงซึ่งแสดงอยูบนแผนที่ของ 
Google ไดทันที แผนที่ ที่แสดงเปนลิขสิทธิ์เฉพาะของ Google  
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3. ขอกําหนดทางเทคนิค 
ตัวเครื่ อง 
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4. เริ่มตนใชงาน 
4.1 ชุดอุปกรณ 
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4.2  การชารจแบตเตอรี่ 
กอนใชงาน TR-102 ควรปฏิบัติดังตอไปนี้ใหครบถวน 
1. ชารจแบตเตอรี่ใหเต็มกอนใชงาน TR-102 ครั้งแรก ใหใชตัวชารจไฟบานชารจ

แบตเตอรี่ไวอยางนอย 10 ช่ัวโมง โดยไมตองเปดเครื่อง (แบตเตอรี่ที่ใชกับ TR-
102 ออกแบบมาโดยเฉพาะ ควรใชแบตเตอรี่ของ TR-102 เทานั้น โปรดติดตอ
ตัวแทนจําหนายของ GlobalSat)  

2. ใส SIM การด ตามรูปขางลางนี้ 
3. ติดต้ังซอรฟแวร ดูรายละเอียดในบทที่ 6 

4.3 การใส SIM การด 
 
 
 
 
 
 
 
 
 
 
ติดต้ัง SIM การด 

1. กดฝาครอบแบตเตอรี่ เล่ือนฝาลงเพื่อเปดออก 
2. ดึงแบตเตอรี่ออก 
3. เสียบ SIM การดเขาในชองตามรูป ปดชองเล่ือนล็อคใหเรียบรอย 
4. ใสแบตเตอรี่ ปดฝาครอบ 
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5. ตัวเครื่องโดยสังเขป 
5.1 รูปลักษณ 
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5.2 รายละเอียดปุมกด 
 
 
Power button 

 
ปุมปด/เปดเครือ่ง ดูรายละเอียดขอ 7.1 
 

 
SOS button 

 
ตั้งเลขหมายได 3 หมายเลขสาํหรับปุมกด SOS เม่ือกดปุมน้ี TR-102 
จะสงคาพิกัดตาํแหนงไปยังเลขหมายทั้ง 3 นี ้โดย SMS  
TR-102 จะโทรหาเลขหมายที่ 1 แลวสงขอมูลพิกัดตําแหนงดวย SMS 
แลวตามดวยการสงไปยัง เลขหมายที่ 2 และ 3 ตามลําดับ 
 

 
Answer / Hang up 

 
เม่ือมีสายเรยีกเขา กดปุมน้ีเพ่ือตอบรับ และกดปุมน้ีอีกครั้งเพ่ือวางสาย 
 

 
Quick dial 1 / Volume up 

 
ตั้งเบอรโทรไวสําหรับปุมน้ี เม่ือกดปุมก็จะโทรออกได ขณะสนทนากด
ปุมน้ีจะเพิ่มระดบัเสียงสนทนาได 
 

 
Quick dial 2/ Mute the 
microphone 

 
ตั้งเบอรโทรสําหรับปุมน้ี เม่ือกดปุมก็จะโทรออกได ขณะสนทนากดปุมน้ี
จะตดัเสียงสนทนา เม่ือกดปุมอีกครั้งเสียงสนทนาจะกลับมา 
 

 
Quick dial 3 / Volume down 

 
ตั้งเบอรโทรไวสําหรับปุมน้ี เม่ือกดปุมก็จะโทรออกได ขณะสนทนากด
ปุมน้ีจะลดระดบัเสียงสนทนา 
 

 
GSM LED 

 
ไฟ LED สวาง คือ เปด TR-102 แตยังไมตอกับระบบ GSM 
ไฟกระพริบเร็ว (1 ครั้ง/วินาท)ี TR-102 กําลังโทรหรืออยูในการสนทนา 
ไฟกระพริบชา (1 ครั้ง/3วินาท)ี TR-102 กําลังอยูในโหมดเตรียมพรอม 
 

 
GPS LED 

 
ไฟ LED กระพริบเมื่อ TR-102 จับตําแหนงได ดูรายละเอียดเรื่องปุม 
SOS หนา 21 และเรื่องโหมด GPRS หนา 27 
 

 
Power LED 

 
ไฟ LED จะเปนสีสมเมื่อชารจแบตเตอรี่ แตเม่ือไฟแบตเตอรี่ออน ไฟ 
LED จะเปนสีแดง 
 

 
Power adapter jack 

 
เสียบปลั๊กนีท้ี่ตวั TR-102 เพ่ือชารจแบตเตอรี ่
 

 
Mini USB connector 

 
ตอ TR-102 ไปยัง PC ดวยสาย Mini USB ก็สามารถตั้งคาตาง ๆ ได
ทั้งหมดจากซอรฟแวรใชงาน 
 

 
Button Lock 

 
ล็อคปุมกดทั้งหมดเพื่อมิใหไปกดปุมตาง ๆ โดยบังเอิญ (เฉพาะปุม 
Power ที่ไมสามารถล็อคได เม่ือล็อคปุมกดแลวไปกดปุมใด ๆ ไฟ LED 
จะสวางข้ึนสามครั้ง) 
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6. การตั้ง TR-102 และการปฏิบัติการของ Call Center 
6.1 ติดตั้ง USB Driver  

1. ใส CD ในถาด CD-ROM เมื่อหนาตางเปดขึ้นโดยอัตโนมัติ คลิกที่  Install USB 
Driver เพื่อติดต้ังไดรฟเวอรใหกับ TR-102 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. จะเห็นหนาตางที่หนึ่ง ใหคลิกท่ี Next 
3. เมื่อติดต้ังเสร็จสมบูรณแลว คลิกท่ี Finish เพื่อปดหนาตางที่ 2 
4. Reboot เครื่อง  PC ใหมเพื่อใชงาน USB Driver 
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6.2 ติดตั้งโปรแกรม Call Center 
1. จากหนาตางแรกคลิกไปที่ “Install PC Software” เพื่อติดต้ัง โปรแกรม  
    Call Center 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. ทําตามคาํแนะนําของหนาตางที่ 1 เพื่อดําเนินการติดต้ัง 
 
3. เมื่อติดต้ังเสร็จสมบูรณ คลิกท่ี  Finish  เพื่อปดหนาตางที่ 2 
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6.3 การปฎิบัติการใน Call Center 
  

 
Menu item 

 
Icon button 

 
Description 

 
 
File > Save File 
(KML) 

  
บันทึกขัอมูลเปนรูปแบบ KML ซึ่งสามารถสงขอมูล KML ไปยัง Google 
Earth  แลวจะแสดงตําแหนงเสนทางได หนาท่ีของรายการนี้ใชในการ
คนหาขอมูลท่ีบันทึกมา 
 

 
File > Exit 

  
ปดโปรแกรม Call Center 
 

 
View > GPRS 
Tracking 

  
เปล่ียนไปใช โหมดติดตามดวย  GPRS ซึ่งสามารถดูขอมูลของ  TR-102  
แบบออนไลนได 
 

 
View >Show Map 

  
ใชแสดงตําแหนงบน  Google Map หรือ Google Earth  
 

 
View > Search 
Records 

  
ใชในโหมดคนหาขอมูล สามารถเสาะหาขอมูลของผูใชตามชวงเวลา เมื่อ
คลิก  2 คร้ัง ในแตละรายการ ก็จะแสดงตําแหนงบน Google Map หรือ 
Google Earth 
 

 
Management > 
User Information  

  
แสดงขอมูลของผูใช ซึ่งสามารถตั้งได 5 ผูใชสําหรับโปรแกรม Call 
Center นี ้
 

 
Management > 
User Edit 

  
ใชลบชื่อผูใชออก โปรแกรม Call Center ใชไดกับผูใชสูงสุด 5 คน ถา
ตองการเพิ่มผูใชเขาไปอีกตองลบผูใชเดิมออกกอนหนึ่งคน 
 

 
Management > 
Setup 

  
เมื่อตอ TR-102 กับ PC สามารถตั้งคา TR-102 ได 
 

 
GPRS > Start 

  
เร่ิมใหCall Center เชื่อมตออินเตอรเน็ต ซึ่งจะสงคําสั่งไปยัง TR-102 ได
ตอเมื่อมีการออนไลน 
 

 
GPRS > Pause 

  
หยุด Call Center ไมใหเชื่อมตอกับอินเตอรเน็ตชั่วขณะ เมื่อ Call Center  
ออนไลนอยูจะไมสามารถตั้งคาใด ๆ ได ตองหยุดชั่วขณะเสียกอน 
 

 
GPRS > Send 
Command to TR-
102 
 

 
 

 
สงคําสั่งไปยัง TR-102 
 

 
Map > Google 
Map 

  
ต้ังใหแสดงตําแหนงดวย  Google Map 
 

 
Map > Google 
Earth 

  
ต้ังใหแสดงตําแหนงดวย  Google Earth 
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6.4 การตั้งคาเบื้องตน 
1. ตอสาย  USB  จาก TR-102  ไปยัง PC  เมื่อติดต้ังไดรเวอรเสร็จแลว 
2. เปดเครื่อง TR-102 

(i) คอยจนกวาเครื่องเปดเรียบรอย 
(ii) กดปุม “Answer/Hang up”  คางไว  5 วินาที จนเห็นไฟ LED  ทั้ง 3 

ดวง กระพรบิชา ๆ พรอมกัน ปลอยปุมเครื่องก็จะอยูในโหมดการตั้งคา 
3. เริ่มเปดโปรแกรม Call Centerของ TR-102 (หรือคลิก 2 ครั้งที่ TR-102 ไอคอน

ในหนาจอ) 
 
 

4. คลิก Management > Setup  ในรายการเมนู แลวคลิก Scan  เพื่อหา COM port 
ที่ TR-102  ตออยู (รูปที ่1 ) เมื่องหาไดแลวคลิก OK  ก็จะตั้ง COM port  ที่
ถูกตองโดยอัตโนมัติ 

 
 
 
 
 
 

 
 
 
5. คลิกท่ี Setup (รูปที่ 2) เปดหนาตางตั้งคา 

 
 
 
 
 
 
 
 
 

6. สําหรับรายละเอียดในการตั้งคาให ดูตามหนาตอไป 
 
หมายเหตุ ถา SIMการด มีรหัส PIN 
อยู จะมีหนาตางเปดขึ้นมาเพื่อใหใส 
PIN กอน ใหระวังในการปอนขอมูล 
รหัส PIN เพราะปอนผิดไดเพียง 3 
ครั้ง SIMการดจะ ล็อคตัวเองทันที 
ถาไมทราบรหสั PIN ใหติดตอกับ
ผูใหบริการSIMการดนั้น ๆ 
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Item Option Description 

GPRS TR-102  จะสงขอมูลตําแหนงกลับ โดย GPRS  

SMS TR-102  จะสงขอมูลตําแหนงกลับโดย SMS 

OFF 

TR-102 จะไมมีเสียงดัง ผูใชรับโทรศัพทไมไดเมื่อ
ไดรับเสียงเรียกเขาหรือ SMS  TR-102 จะสงขอมูล
ตําแหนงกลับ โดยวิธีของ  “Return Type” (ใหดูรูปที่ 
3 ในหนา 32) 

 

ON 

เมื่อรับสายเรียกเขา TR-102 จะมีเสียงดัง ผูใชรับ
โทรศัพทได (ใหดูรูปที่ 1 ในหนา 32) เมื่อรับ SMS 
TR-102 จะสงขอมูลตําแหนงกลับโดยวิธี “ Return 
Type” (ใหดูรูปที 2 ในหนา 32) 

 1~10 ตั้งชวงเวลาจับสัญญาณ  GPS เปนนาที 

OFF TR-102 จะสงขอมูลตําแหนงกลับทุกสายที่เรียกเขา  

ON TR-102 จะสงขอมูลตําแหนง กลับเฉพาะสายเรยีกเขา
ที่มีอยูในรายชื่อโทรศัพท 

ON SMS ที่สงมาจาก TR-102 จะมีคาเวลาทองถิ่นดวย  

OFF SMS ที่สงมาจาก TR-102 จะมีคาเวลา  Coordinated 
Universal Time  หรือ  UTC อยูดวย 
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หมายเหตุ : SMS ที่สงมาจาก TR-102 ไปเครื่องโทรศัพทมือถือน้ันจะอยูในรูปแบบดังน้ี 
  Position Report : 
  TR-102 
  2005/01/02  11:20:30 
  24.9965, 121.4877 
  GPS Fixed 

• บรรทัดท่ีสองแสดงชื่อผูใช (คาที่ตั้งคือ “TR102”) 
• บรรทัดท่ีสาม คือ วัน เวลา (yyyy/mm/dd  hh:mm:ss) 
• บรรทัดท่ีสี่ คอื คาลองติจูด และ ละตจูิด ซึ่งสามารถสําเนาคานี้ไปใสใน Google Earth หรือ 

maps.google.com หรือแผนที่อื่น ๆ ที่รองรับ เพื่อดูตําแหนงบนแผนที่ 
• บรรทัดท่ีหา คือ การจับสญัญาณ GPS ไดหรือไม (ถาจับสัญญาณไมได ขอมูลของบรรทัดท่ี

สามและสี่ จะเปนของจุดสุดทายที่จับสัญญาณไ ด) 
 
 
 
 
 
 
 
 
 
 
 
 
 

item Description  
SOS  
Number  
1 ~ 3 

เมื่อกดปุม SOS TR-102 จะ
โทรไปหา 3 เลขหมายพรอม
กับสง SMS ขอมูลพิกัด
ตําแหนงไปดวย (ดูรูปที ่4 ใน
หนา 33) 

 
 
 
 
 

Quick Dial 
1 ~ 3 

ใสเลขหมายที่ตองการโทร
ออก 3 หมายเลขตามกํากับ 
(ดูรูปที่ 5 ในหนา 33) 
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item description 
เลขหมาย
โทรศัพท  
1~3 

3 เลขหมายนี้จะเหมือนกับเบอร 
Quick Dial ไมสามารถแกไข
จากหนาตางนี ้

เลขหมาย
โทรศัพท 
4~10 

ตั้งเลขหมาย 4-10 

 
 
 
 
 
 
 
 
 
 
 
 

item description 
IMEI International Mobile 

Equipment Identity 
Firmware 
Version 

Firmware version of TR-102 

Name ใสชื่อผูใชในชองนี้ (คาทีต่ั้งไว 
คือ TR-102) 

Phone ใสเลขหมายโทรศัพทของ TR-
102 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

item description 
GPRS user name 
GPRS user password 
GPRS apn 
GPRS_dns1 
GPRS_dns2 

โปรดขอคําแนะนํา
ในการตั้งคาจากผู
ใหบริการ GPRS 
ของทาน 

 
 
 
 
 
 
 
 
 
 
 

item Description 
GPRS Port คาทีต่ั้งไว คือ “5000” 
GPRS Sever 
Host Name 

ตั้งชื่อ GPRS Server Host 
Name 
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7. การใชงานเครื่อง 
7.1 การเปดปดเครื่อง 

• การเปด เมื่อเครื่องปดอยู ใหกดปุมปด/เปด 
คางไว 3 วินาที ไฟ LED ทั้ง 3 ดวง จะ
กระพริบไลเรียงจากบนลงลางแลวจะเขาสู
โหมดเตรียมพรอมโดยไฟ LED จะกระพริบ
ชา ๆ ถือวาเปดเครื่องเรียบรอยแลว 
(ระหวางกําลังเปดเครื่อง จะปดเครื่อง
ไมได) เมื่อเปดเครื่องแลว GPS จะเริม่
ทํางานหาตําแหนงเครื่อง โดยไฟ LED สี
เขียวจะเปดประมาณ 2-3 วินาที แลวจะดับ
ไป ถาหาตําแหนงไมไดใน 3 นาที GPS ก็
จะหยุดไป 30 นาที แลวจึงคนหาใหม ขอ
แนะนําใหอยูภายนอกอาคารเพื่อใหรับ
สัญญาณดาวเทียมไดดียิ่งขึ้นขณะเปดเครื่อง 

• การเปด เมื่อเครื่องเปดอยูกดปุม ปด/เปด คางไว 3 วินาทีไฟ LED ทั้ง 3 ดวงจะ
กระพริบชา ๆ จากลางขึ้นบน เมื่อไฟ LED ดับไปแลว แสดงวาปดเครื่องเรียบรอยแลว 

7.2 การตอบรับและวางสายโทรศพัท 
• เมื่อมีสายเรียกเขา กดปุมน้ีเพื่อรับสาย 
• ขณะสนทนา กดปุมน้ีเพื่อวางสาย 
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7.3 การปรับเสียงหูฟง 
• ขณะสนทนา สามารถเพิม่ระดับเสียงไดโดยกดป

“+” 
ุม 

• เมื่อกดปุมน้ีขณะสนทนา ผูที่โทรมาจะไมไดยิน
เสียงพูดของคุณ  กดปุมน้ีอีกครั้งเพื่อสนทนาตอ
ไดอีก 

• ขณะสนทนา สามารถลดระดับเสียงไดโดยกดปุม 
“-” 

 
 
 

7.4 การโทรออก 
• เมื่อต้ังคาเลขหมาย Quick Dial แลวกดปุม Quick 

Dial เมื่อโทรออกไปยังเลขหมายที่ตั้งไว การกดปุม 
Quick Dial ใหกดคางไวเกิน 1 วินาที แลวปลอย 
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7.5 การสง SMS แบบฉุกเฉิน 
• เมื่อต้ังคาเลขหมายสําหรับการสง SOS 

เรียบรอยแลวกดปุม SOS TR-102 ก็จะสง
ขอมูลตําแหนงไปยัง 3 เลขหมายที่ตั้งไวโดย 
SMS เพื่อหลีกเล่ียงการกดปุม SOS โดยบ
ใหกดปุม SOS น้ีคางไว 2 วินาที แลวปลอย ก็
จะสง SOS แบบฉุกเฉิน 

ังเอิญ 

• TR-102 จะโทรหา SOS เลขหมายที่ 1 เพื่อสง
ขอมูลตําแหนง และโทรหา SOS เลขหมายที่ 2 
และท่ี 3 ตามลําดับ 

 
เมื่อกดปุม SOS เครื่องจะทํางานอยางไร 
1. เพื่อยืนยันวามีการกดปุม SOS อยางถูกตอง 

TR-102 จะมีไฟ LED สแีดงกระพริบ 2 ครั้ง 
2. TR-102 จะคนหาตําแหนงตัวเองโดยแสดงไฟ GPS LED กระพริบ เมื่อจับสัญญาณได ไฟ 

LED จะเปดคาง 
3. TR-102 ก็จะปด GPS ไฟ LED สีเขียวจะดับ 
4. TR-102 เริ่มสงขอมูลตําแหนงดวย SMS โดยไฟ LED สีนํ้าเงินจะกระพริบ 1 ครั้งตอวินาที 
5. เมื่อสง SMS เสร็จแลว ไฟ LED สีนํ้าเงินก็จะกลับสูโหมดเตรียมพรอมโดยกระพริบ 1 ครั้งตอ 

3 วินาที 
6. ถาสง SMS ไดเรียบรอย TR-102 จะกระพริบไฟ LED สีแดง 2 ครั้ง 
7. ถาจับสัญญาณ GPS ไมไดใน 3 นาที ก็จะสง SMS ดวยขอความ “no fixed” และขอมูล

ตําแหนงสุดทายที่จับสัญญาณได 
 

8. การติดตามดวยโหมด SMS 
 8.1 การตั้งคารูปแบบการสง SMS 

• ตอ TR-102 เขากับ 
PC ทางชอง USB 

• เขาไปยังโหมดตั้ง
คา เลือกโหมด
โทรศัพทแลวเลือก 
SMS ใน  Return 
Type 
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8.2 การสง SMS จากโทรศัพทมือถือไปยัง TR-102 
• สง SMS ไปยัง TR-102 เพื่อใหสงขอมูลพิกัดตําแหนงกลับมา (ขอความที่สง SMS เปนอะไร

ก็ได หรือ ขอความวาง) 

8.3 TR-102 สง SMS ไปยังโทรศพัทมือถือ 
• เมื่อ TR-102 รับ SMS มาแลว ก็จะสงขอมูลพิกัดตําแหนงทาง SMS กลับมาในรูปแบบดังน้ี 

Position Report : 
TR-102 
2005/01/02   11:20:30 
24.9965, 121.4877 
GPS fixed 

 
 
 
 

8.4 การแสดงตําแหนงบนแผนที่  
• เปด Google Earth ขึ้นมากอน (รายละเอียดเพิ่มเติมของ Google Earth ดูไดใน “TR-102 

Supporting User Manual En_Free Google Earth Software.pdf” ซึ่งอยูใน CD-ROM ใน
แฟม “Manual”) 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

ใสคา Latitude/ 
Longtitude ที่ไดรับ
จาก SMS แลวคลิก 
Search เพื่อคนหา 

Google Earth จะ
แสดงตําแหนงบน
แผนที่ 
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• หรือเขาไปใน Internet Explorer และพิมพ “http://maps.google.com” เพื่อเขาไปยงั 
Google Map Website ซึ่งจะแสดงตําแหนงบนแผนที่เชนกัน 

 
 
 
 
 
 
 

เลือก Satellite 
หรือ Hybrid ทั้งน้ี
แลวแตพ้ืนที่นัน้จะ
มี Google Map 
รองรับหรือไม 

 
 
 
 
 
 
 ใสคา Latitude / 

Longtitude ทีไ่ด
จาก SMS แลว
คลิกที่ Search 

 
 
 
 
 
 
 Google Map ก็จะ

แสดงตําแหนงบน
แผนที ่
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9. การติดตามดวยโหมด GPRS 
     9.1 การตั้งคารูปแบบการสง GPRS 

• ตอ TR-102 กับ PC ทางชอง USB 
• เขาไปที่ Setup เลือกโหมดโทรศัพทแลวเลือก GPRS ที่ชอง Return Type 

 

 
 

9.2 การสั่งให TR-102 เชื่อมตอ Internet ดวย GPRS 
• ถา Answer Mode เปน Off ใชโทรศัพทมือถือโทรหา TR-102 หรือสง SMS ไปยัง TR-102 

เพื่อสั่งใหตอเขา Internet 
• ถา Answer Mode เปน On จะสงไดเพียง SMS เพื่อสั่งให TR-102 ตอเขา Internet 
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     9.3 การสงคําสัง่จาก Call Center ไปยัง TR-102  
•  สามารถสงคําสั่งไปยัง TR-102 โดยวิธีตอไปน้ีเพื่อให TR-102 สงขอมูลตําแหนง  กลับมา 

1) เปดโปรแกรม Call Center แลวคลิกไปที่ “GPRS”>”Start” บนแถบเมนู เพื่อ
เช่ือมตอไปยัง  Internet 

2) คลิก “GPRS”>”Send Message” เพื่อเปดหนาตางสงคําสั่ง 
3) เลือก Name, Return Mode และ Return Time ตามแตกรณี แลวคลิก OK 

เพื่ อสงคําสั่งออกไป 
4) โปรดดูตารางตอไปถึงวิธีที่จะเลือก “Return Mode” หรือ “ Return Time”. 
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Return Mode 
 

 
Return Time 
(second) 
 

 
Description 
 

 
Immediate 
report 

 
N/A 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะสงขอมูลกลับทันทีโดยจะสง
หนึ่งถึงสองครั้ง การเชื่อมตอ GPRS ยังคงอยู ขณะที่ TR-102 
อยูในโหมดนี้ไฟ LED สีน้ําเงินจะกระพริบ 1 ครั้งตอวินาที แลว
เริ่มจับสัญญาณ GPS โดยไฟ LED สีเขียวจะกระพริบ เมื่อจับ
สัญญาณไดแลวก็จะสงขอมูล ไฟ LED สีเขียวก็จะเปดคาง 
จนกวาจะมีคําสั่งครั้งตอไปใหสงขอมูลอีก 
 

 
Period report 

 
5 ~ 86400 
seconds 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะสงขอมูลกลับทุก ๆ ชวงเวลา
ตามที่ตั้งไว และการเชื่อมตอ GPRS ยังคงอยูเมื่อถึงชวงเวลา
ที่ตั้งไวแลว TR-102 จะเริ่มจับสัญญาณ GPS ไฟ LED สีเขียว
จะกระพริบ เมื่อจับสัญญาณไดแลว สงขอมูลไป ไฟ LED สี
เขียวจะเปดคางจนกวาสิ้นสุดชวงเวลา แลวจึงเริ่มใหมอีกครั้งใน
ชวงเวลาตอไปเรื่อย ๆ 
ความคลาดเคลื่อนของเวลาในการสงขอมูลกลับประมาณ 1-3 
วินาที หรือมากกวา ถาการเชื่อมตอ GPRS ไมเสถียร 
 

 
Stop connect 

 
N/A 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะหยุดการเชื่อมตอ GPRS และ
กลับไปสูโหมดหยุดนิ่ง 
 

 
Stop connect 
and set 
period report 

 
30 ~ 86400 
seconds 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะสงขอมูลกลับทันทีโดยจับ
สัญญาณ GPS ไฟ LED สีเขียวกระพริบ เมื่อจับสัญญาณไดไฟ 
LED สีเขียวเปดคาง และเชื่อมตอ GPRS เพื่อสงขอมูล โดยไฟ 
LED สีน้ําเงินกระพริบ 1 ครั้ง ตอวินาที หลังจากนี้ก็จะปด GPRS 
แลวอยูในโหมดหยุดนิ่ง ไฟ LED สีเขียวดับ ไฟ LED สีน้ําเงิน
กลับมาอยูในสถานะพรอม เมื่อครบชวงเวลาก็จะเริ่มใหม
เชื่อมตอ Internet แลวสงขอมูลอีก แสร็จแลวก็กลับเขาโหมด
หยุดนิ่งอีกครั้ง จะทํางานในลักษณะนี้ เมื่อถึงชวงเวลาที่ตั้งไว
ตอไปเรื่อย ๆ 
เนื่องจากเมื่อจับสัญญาณ GPS ไดแลวจะหยุดไปจนครบ
ชวงเวลาแลวจึงเริ่มจับสัญญาณใหม ทําใหตองใชเวลาบางใน
การจับสัญญาณ GPS ดังนั้นถาสัญญาณ GPSไมแรงพออาจ
ตองใชเวลามากกวา 3 นาที ในการจับสัญญาณ (และยังขึ้นอยู
กับความเสถียรของการเชื่อมตอ GPRS ดวย) 
 

 
1. ดูรายละเอียดการตั้ง Return Mode และ Second ไดทีไ่ฟล “TR-102 GPRS Access command 

Vx.x.pdf” ใน CD-ROM แฟม “Manual” 
2. เมื่อเปดเครื่อง TR-102 จะจําเอา “Return Mode” จากครั้งกอนที่จะปดเครื่อง 
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9.4 TR-102 สงขอมูลตําแหนงกลบัมายัง Call Center  
• เมื่อ TR-102 ไดรับคําสั่ง ก็จะสงขอมลูตําแหนงกลับมาโดย GPRS ใหคลิกท่ี GPRS ใน Call 

Center Program ก็จะเห็นขอมูลลาสุดอยูแถวบนสุดของรายการ 
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     9.5 การแสดงตําแหนงบนแผนที่ 
o คลิกที่ Map บนแถบเมนู เลือกใหโปรแกรม 

แสดงบน Google Map หรอื Google Earth 
o ถาคลิกที่ “View”>”Show Map” โปรแกรม 

Call Center จะให Google Map หรือ 
Google Earth ปรับปรุงการแสดงผลเมื่อรับ
ขอมูลใหม 

o หรือคลิก 2 ครั้ง ในแตละรายการก็จะแสดง
ตําแหนงบน Google Map หรือ Google 
Earth 
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10. รูปแบบการทํางานของ TR-102 ดวย SMS และ GPRS 
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11. การแกปญหาขัดของ และขอมูลความปลอดภัย 
 

อาการ สาเหตุ การแกไข 

ไมไดใสSIMการด ใหใสSIMการดเขาใน TR-
102 

ถาเปดเครื่อง TR-102 แลว
ไฟ LED 3 ดวงกระพริบ
พรอมกัน 

ใสSIMการดแลว แตมีรหัส 
PIN ปองกันการเขาถึงและ
ใสรหัสไมถูกตอง 

เอาSIMการดออกมาใสใน
โทรศัพทเพื่อปลดล็อคการ
ใสรหัส PIN แลวจึงใสSIM 
กลับเขาไปใน TR-102 ใหม
เมื่อยูในโหมด Setup ก็จะไม
ถามหารหัส PIN อีกตอไป 

หรือตอ TR-102 เขาไปที่ 
PC เปด  Setup Mode ใน 
Call Center Program เพื่อ
ใสรหัสที่ถูกตอง 

เมื่อเปด TR-102 แลวไฟ 
LED สีนํ้าเงินเปดแสดง
สถานะ GSM 

สัญญาณ GSM ออน ใหเคล่ือนยายไปบริเวณท่ีมี
สัญญาณแรงกวา 

 
• หาขอมูลเพิ่มเติมเรื่  อง Google Earth Software และ Free DDNS Service, ใหดูที่ “TR-101 

Supporting User Manual EN 1_ Free DDNS Service.pdf” และ “TR-101 Supporting 
User Manual En_Free Google Earth Software.pdf” ซึ่งอยูใน CD-ROM ในแฟม 
“Manual” 

• ในสถานะการณทั่วไป ควรชารจแบตเตอรี่ประมาณ 4-5 ช่ัวโมง โดยปดเครื่องไฟก็จะเต็ม ถา
ชารจโดยเปดเครื่องดวยก็จะใชเวลานานกวานี้ 

• ฝาปดชองตอ USB ของ TR-102 จะมีเดือยเล็ก ๆ อยู (ดูในรูป
ขวามือ) ใหกดลงดวยความแรงเล็กนอยเพื่อปดใหสนิท ซึ่งจะมีเสียง
คลิกเบา ๆ เมื่อปดสนิท 

• อยาตอ TR-102 กับตัวอแด็ปเตอรชารจไฟ ขณะที่กําลังจะเปดเครื่อง 
มิฉะน้ันจะเปดเครื่องไดไมสมบูรณ 

• อยาตอ TR-102 เขาชอง USB ขณะทีเ่ปลื่ยนแบตเตอรี่มิฉะน้ัน จะมี
เสียงดัง 

• ถาปด TR-102 ไมได ใหเปดฝาถอดแบตเตอรี่ออก 3 วินาทีเปนอยางนอย ใสแบตเตอรี่กลับ
แลวเปดใหมอีกครั้ง  
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• เมื่อคลิกท่ี KMLจะสงขอมูลไดก็ตอเมื่อ 
มีรายการที่จับสัญญาณ GPS ไดบาง 
(2D หรือ 3D) ถาทุกรายการจับสัญญาณ 
ไมไดเลย “No Fix” ก็จะสงขอมูลเปนไฟล 
KMLไมไดซึ่งจะเห็นขอความ error วา 
“No Effective Data” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• เมื่อเปดเครื่ง จะเริ่มกระบวนการเปดเครื่องตามลําดับ จะไดยินเสียง ตูด จากลําโพง ซึ่งเปน
เรื่องปกติ ไมมีปญหากับตัวเครื่อง 

• โปรดหลีกเล่ียงการเก็บวางอุปกรณไวในที่มีความรอนสูงหรือความชื้นมาก และอยาทิ้งเครื่อง
ไวในรถที่ปดสนิทจอดอยูกลางแดด ความรอนที่สูงมากอาจทําความเสียหาย ใหกับอุปกรณ 
หรือ แบตเตอรี่ อาจระเบดิได 

• เมื่อใช  TR-102 โทรออก แตผูรับไมตอบรับ (ไมรวมถึงการปดเครื่อง สายไมวาง หรือวาง
สาย) จนเขาสูโหมดการฝากขอความดวยเสียง (Voice box) ถาไมตองการฝากขอความ 
โปรดแนใจวาไดกดปุมวางสายที่ TR-102 เรียบรอยแลว มิเชนน้ัน TR-102 จะเปดติดตอกับ
ระบบฝากขอความ และไมสามารถกลบัมาอยูในโหมดเตรียมพรอม 

• อยาถือ TR-102  แนบหูเมื่อมีเสียงเรียกเขา เมื่อตองการรับโทรศัพท ใหกดปุมตอบรับกอนที่
จะนํา TR-102  มาฟงเสียง ทั้งน้ีเพื่อปองกันอันตรายจากการฟงเสียงดังเกินขนาด 
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